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1. คํานํา 
TR-102 คืออุปกรณแจงบอกตําแหนงระยะไกลที่บรรจุ GPS และ GPRS ไวดวยกันรูปราง

กระทัดรัด พกพาสะดวก ซึ่งไมเพียงแต TR-102 สามารถสงคาพิกัดตําแหนงไปยังโทรศัพทมื่อถือ
ดวย SMS เทานั้นยังจะสามารถสงคาพิกัดตําแหนงไปยัง PC ไดอีก ดวยการเชื่อมตอทางอินเตอรเน็ต
โดยGPRS อีกท้ังยังแสดงคาพิกัดตําแหนงน้ันบนซอรฟแวรแผนที่เฉพาะไดอีก TR-102 มีปุมโทรออก
อัตโนมัติ 3 เลขหมาย และปุมสงขอความฉุกเฉินหนึ่งปุม ดวยคุณลักษณะอยางนี้ทําใหสามารถ
ปองกัน หรือคนหาตําแหนงของเด็ก หรือคนชราที่หลงทางได และยิ่งไปกวานั้นยังสามารถใช TR-
102 ในเรื่องความปลอดภัย หรือจุดประสงค   อื่นใดที่เกี่ยวของกับการแจงบอกตําแหนงระยะไกล 
 

2. คุณลักษณะ 
1. เปนเครื่องคนหาตําแหนงสวนตัวดวย GPS/GPRS 
2. สื่อสารดวยระบบ GSM/SMS/GPRS 
3. ตัวรับสัญญาณ GPS ความไวสูงรับสญัญาณไดทุกทิศทาง 
4. Chipset รุน SiRF Star III ใหมล าสุดจับตําแหนงไดอยางยอดเยี่ยม แมในบริเวณท่ีมี

สัญญาณอ อน 
5. ระบบควบคุมระยะไกล สั่งงานผานโทรศัพทมือถือหรือดวยโปรแกรมออนไลน 
6. ตอบรับโทรศัพทได เปนการสื่อสารสองทาง 
7. ผูเฝามองสามารถติดตามบุคคลไ ดโดยไมตองรบกวนผูถูกติดตาม เปนการติดตามแบบ 

Real–Time 
8. คนหาตําแหนงของผูถืออุปกรณน้ีได เพียงแคกดปุมบน PC หรือ ผานโทรศัพทมือถือ

ดวย SMS (Short Messaging System) 
9. โทรออกได 3 เลขหมายตามที่ตั้งคาเอาไว 
10. ใชงานไดทั่วโลก เน่ืองจากสนับสนุนระบบคลื่น 4 ระบบ คือ GSM 

850/900/1800/1900 MHz GPRS และ Class 12 
11. ปุมฉุกเฉิน SOS จะสงคาตําแหนงที่แนนอน เพื่อการชวยเหลือดําเนินการอยาง

ทันทวงที 
12. ปุมฉุกเฉิน SOS แยกอิสระชัดเจน จะสงคาพิกัดตําแหนง GPS ผาน SMS ไปยังเลข

หมายที่ตั้งไวทันที เลขหมายฉุกเฉินที่ตั้งไวแตกตางจาก 3 เลขหมายโทรออกที่ตั้งไว
เ ดิมได 

13. อุปกรณสามารถเชื่อมตอกับ PC ทางชอง USB เพื่อต้ังคาใชงานตาง ๆ สายเคเบิล 
USB เปนอุปกรณใหมากับตัวเครื่อง 

14. ใหรายงานตําแหนงผูใชงานไดตามชวงเวลาที่ตั้งไว 
15. แสดงสถานะแบตเตอรี่ออนกอนไฟหมด ตัดความกงัวลวาจะไมสามารถติดตอไดใน

สถานะการณเฉพาะหนา 
 

คุณลักษณะซอรฟแวร 
โปรแกรม Call Center อันทรงประสิทธิภาพซึ่งใชไดใน Window 98/2000/XP สามารถรองรับการ
ติดตาม TR-102 ไดถึง 5เครื่องในเวลาเดียวกันดวยการใชงานในโหมด GPRS คลิกท่ีช่ือผูใช TR-
102 เครื่องใดเครื่องหน่ึงในโปรแกรม Call Center ก็จะดูพิกัดตําแหนงซึ่งแสดงอยูบนแผนที่ของ 
Google ไดทันที แผนที่ ที่แสดงเปนลิขสิทธิ์เฉพาะของ Google  
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3. ขอกําหนดทางเทคนิค 
ตัวเครื่ อง 
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4. เริ่มตนใชงาน 
4.1 ชุดอุปกรณ 
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4.2  การชารจแบตเตอรี่ 
กอนใชงาน TR-102 ควรปฏิบัติดังตอไปนี้ใหครบถวน 
1. ชารจแบตเตอรี่ใหเต็มกอนใชงาน TR-102 ครั้งแรก ใหใชตัวชารจไฟบานชารจ

แบตเตอรี่ไวอยางนอย 10 ช่ัวโมง โดยไมตองเปดเครื่อง (แบตเตอรี่ที่ใชกับ TR-
102 ออกแบบมาโดยเฉพาะ ควรใชแบตเตอรี่ของ TR-102 เทานั้น โปรดติดตอ
ตัวแทนจําหนายของ GlobalSat)  

2. ใส SIM การด ตามรูปขางลางนี้ 
3. ติดต้ังซอรฟแวร ดูรายละเอียดในบทที่ 6 

4.3 การใส SIM การด 
 
 
 
 
 
 
 
 
 
 
ติดต้ัง SIM การด 

1. กดฝาครอบแบตเตอรี่ เล่ือนฝาลงเพื่อเปดออก 
2. ดึงแบตเตอรี่ออก 
3. เสียบ SIM การดเขาในชองตามรูป ปดชองเล่ือนล็อคใหเรียบรอย 
4. ใสแบตเตอรี่ ปดฝาครอบ 
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5. ตัวเครื่องโดยสังเขป 
5.1 รูปลักษณ 
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5.2 รายละเอียดปุมกด 
 
 
Power button 

 
ปุมปด/เปดเครือ่ง ดูรายละเอียดขอ 7.1 
 

 
SOS button 

 
ตั้งเลขหมายได 3 หมายเลขสาํหรับปุมกด SOS เม่ือกดปุมน้ี TR-102 
จะสงคาพิกัดตาํแหนงไปยังเลขหมายทั้ง 3 นี ้โดย SMS  
TR-102 จะโทรหาเลขหมายที่ 1 แลวสงขอมูลพิกัดตําแหนงดวย SMS 
แลวตามดวยการสงไปยัง เลขหมายที่ 2 และ 3 ตามลําดับ 
 

 
Answer / Hang up 

 
เม่ือมีสายเรยีกเขา กดปุมน้ีเพ่ือตอบรับ และกดปุมน้ีอีกครั้งเพ่ือวางสาย 
 

 
Quick dial 1 / Volume up 

 
ตั้งเบอรโทรไวสําหรับปุมน้ี เม่ือกดปุมก็จะโทรออกได ขณะสนทนากด
ปุมน้ีจะเพิ่มระดบัเสียงสนทนาได 
 

 
Quick dial 2/ Mute the 
microphone 

 
ตั้งเบอรโทรสําหรับปุมน้ี เม่ือกดปุมก็จะโทรออกได ขณะสนทนากดปุมน้ี
จะตดัเสียงสนทนา เม่ือกดปุมอีกครั้งเสียงสนทนาจะกลับมา 
 

 
Quick dial 3 / Volume down 

 
ตั้งเบอรโทรไวสําหรับปุมน้ี เม่ือกดปุมก็จะโทรออกได ขณะสนทนากด
ปุมน้ีจะลดระดบัเสียงสนทนา 
 

 
GSM LED 

 
ไฟ LED สวาง คือ เปด TR-102 แตยังไมตอกับระบบ GSM 
ไฟกระพริบเร็ว (1 ครั้ง/วินาท)ี TR-102 กําลังโทรหรืออยูในการสนทนา 
ไฟกระพริบชา (1 ครั้ง/3วินาท)ี TR-102 กําลังอยูในโหมดเตรียมพรอม 
 

 
GPS LED 

 
ไฟ LED กระพริบเมื่อ TR-102 จับตําแหนงได ดูรายละเอียดเรื่องปุม 
SOS หนา 21 และเรื่องโหมด GPRS หนา 27 
 

 
Power LED 

 
ไฟ LED จะเปนสีสมเมื่อชารจแบตเตอรี่ แตเม่ือไฟแบตเตอรี่ออน ไฟ 
LED จะเปนสีแดง 
 

 
Power adapter jack 

 
เสียบปลั๊กนีท้ี่ตวั TR-102 เพ่ือชารจแบตเตอรี ่
 

 
Mini USB connector 

 
ตอ TR-102 ไปยัง PC ดวยสาย Mini USB ก็สามารถตั้งคาตาง ๆ ได
ทั้งหมดจากซอรฟแวรใชงาน 
 

 
Button Lock 

 
ล็อคปุมกดทั้งหมดเพื่อมิใหไปกดปุมตาง ๆ โดยบังเอิญ (เฉพาะปุม 
Power ที่ไมสามารถล็อคได เม่ือล็อคปุมกดแลวไปกดปุมใด ๆ ไฟ LED 
จะสวางข้ึนสามครั้ง) 
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6. การตั้ง TR-102 และการปฏิบัติการของ Call Center 
6.1 ติดตั้ง USB Driver  

1. ใส CD ในถาด CD-ROM เมื่อหนาตางเปดขึ้นโดยอัตโนมัติ คลิกที่  Install USB 
Driver เพื่อติดต้ังไดรฟเวอรใหกับ TR-102 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. จะเห็นหนาตางที่หนึ่ง ใหคลิกท่ี Next 
3. เมื่อติดต้ังเสร็จสมบูรณแลว คลิกท่ี Finish เพื่อปดหนาตางที่ 2 
4. Reboot เครื่อง  PC ใหมเพื่อใชงาน USB Driver 
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6.2 ติดตั้งโปรแกรม Call Center 
1. จากหนาตางแรกคลิกไปที่ “Install PC Software” เพื่อติดต้ัง โปรแกรม  
    Call Center 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. ทําตามคาํแนะนําของหนาตางที่ 1 เพื่อดําเนินการติดต้ัง 
 
3. เมื่อติดต้ังเสร็จสมบูรณ คลิกท่ี  Finish  เพื่อปดหนาตางที่ 2 
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6.3 การปฎิบัติการใน Call Center 
  

 
Menu item 

 
Icon button 

 
Description 

 
 
File > Save File 
(KML) 

  
บันทึกขัอมูลเปนรูปแบบ KML ซึ่งสามารถสงขอมูล KML ไปยัง Google 
Earth  แลวจะแสดงตําแหนงเสนทางได หนาท่ีของรายการนี้ใชในการ
คนหาขอมูลท่ีบันทึกมา 
 

 
File > Exit 

  
ปดโปรแกรม Call Center 
 

 
View > GPRS 
Tracking 

  
เปล่ียนไปใช โหมดติดตามดวย  GPRS ซึ่งสามารถดูขอมูลของ  TR-102  
แบบออนไลนได 
 

 
View >Show Map 

  
ใชแสดงตําแหนงบน  Google Map หรือ Google Earth  
 

 
View > Search 
Records 

  
ใชในโหมดคนหาขอมูล สามารถเสาะหาขอมูลของผูใชตามชวงเวลา เมื่อ
คลิก  2 คร้ัง ในแตละรายการ ก็จะแสดงตําแหนงบน Google Map หรือ 
Google Earth 
 

 
Management > 
User Information  

  
แสดงขอมูลของผูใช ซึ่งสามารถตั้งได 5 ผูใชสําหรับโปรแกรม Call 
Center นี ้
 

 
Management > 
User Edit 

  
ใชลบชื่อผูใชออก โปรแกรม Call Center ใชไดกับผูใชสูงสุด 5 คน ถา
ตองการเพิ่มผูใชเขาไปอีกตองลบผูใชเดิมออกกอนหนึ่งคน 
 

 
Management > 
Setup 

  
เมื่อตอ TR-102 กับ PC สามารถตั้งคา TR-102 ได 
 

 
GPRS > Start 

  
เร่ิมใหCall Center เชื่อมตออินเตอรเน็ต ซึ่งจะสงคําสั่งไปยัง TR-102 ได
ตอเมื่อมีการออนไลน 
 

 
GPRS > Pause 

  
หยุด Call Center ไมใหเชื่อมตอกับอินเตอรเน็ตชั่วขณะ เมื่อ Call Center  
ออนไลนอยูจะไมสามารถตั้งคาใด ๆ ได ตองหยุดชั่วขณะเสียกอน 
 

 
GPRS > Send 
Command to TR-
102 
 

 
 

 
สงคําสั่งไปยัง TR-102 
 

 
Map > Google 
Map 

  
ต้ังใหแสดงตําแหนงดวย  Google Map 
 

 
Map > Google 
Earth 

  
ต้ังใหแสดงตําแหนงดวย  Google Earth 
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6.4 การตั้งคาเบื้องตน 
1. ตอสาย  USB  จาก TR-102  ไปยัง PC  เมื่อติดต้ังไดรเวอรเสร็จแลว 
2. เปดเครื่อง TR-102 

(i) คอยจนกวาเครื่องเปดเรียบรอย 
(ii) กดปุม “Answer/Hang up”  คางไว  5 วินาที จนเห็นไฟ LED  ทั้ง 3 

ดวง กระพรบิชา ๆ พรอมกัน ปลอยปุมเครื่องก็จะอยูในโหมดการตั้งคา 
3. เริ่มเปดโปรแกรม Call Centerของ TR-102 (หรือคลิก 2 ครั้งที่ TR-102 ไอคอน

ในหนาจอ) 
 
 

4. คลิก Management > Setup  ในรายการเมนู แลวคลิก Scan  เพื่อหา COM port 
ที่ TR-102  ตออยู (รูปที ่1 ) เมื่องหาไดแลวคลิก OK  ก็จะตั้ง COM port  ที่
ถูกตองโดยอัตโนมัติ 

 
 
 
 
 
 

 
 
 
5. คลิกท่ี Setup (รูปที่ 2) เปดหนาตางตั้งคา 

 
 
 
 
 
 
 
 
 

6. สําหรับรายละเอียดในการตั้งคาให ดูตามหนาตอไป 
 
หมายเหตุ ถา SIMการด มีรหัส PIN 
อยู จะมีหนาตางเปดขึ้นมาเพื่อใหใส 
PIN กอน ใหระวังในการปอนขอมูล 
รหัส PIN เพราะปอนผิดไดเพียง 3 
ครั้ง SIMการดจะ ล็อคตัวเองทันที 
ถาไมทราบรหสั PIN ใหติดตอกับ
ผูใหบริการSIMการดนั้น ๆ 
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Item Option Description 

GPRS TR-102  จะสงขอมูลตําแหนงกลับ โดย GPRS  

SMS TR-102  จะสงขอมูลตําแหนงกลับโดย SMS 

OFF 

TR-102 จะไมมีเสียงดัง ผูใชรับโทรศัพทไมไดเมื่อ
ไดรับเสียงเรียกเขาหรือ SMS  TR-102 จะสงขอมูล
ตําแหนงกลับ โดยวิธีของ  “Return Type” (ใหดูรูปที่ 
3 ในหนา 32) 

 

ON 

เมื่อรับสายเรียกเขา TR-102 จะมีเสียงดัง ผูใชรับ
โทรศัพทได (ใหดูรูปที่ 1 ในหนา 32) เมื่อรับ SMS 
TR-102 จะสงขอมูลตําแหนงกลับโดยวิธี “ Return 
Type” (ใหดูรูปที 2 ในหนา 32) 

 1~10 ตั้งชวงเวลาจับสัญญาณ  GPS เปนนาที 

OFF TR-102 จะสงขอมูลตําแหนงกลับทุกสายที่เรียกเขา  

ON TR-102 จะสงขอมูลตําแหนง กลับเฉพาะสายเรยีกเขา
ที่มีอยูในรายชื่อโทรศัพท 

ON SMS ที่สงมาจาก TR-102 จะมีคาเวลาทองถิ่นดวย  

OFF SMS ที่สงมาจาก TR-102 จะมีคาเวลา  Coordinated 
Universal Time  หรือ  UTC อยูดวย 
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หมายเหตุ : SMS ที่สงมาจาก TR-102 ไปเครื่องโทรศัพทมือถือน้ันจะอยูในรูปแบบดังน้ี 
  Position Report : 
  TR-102 
  2005/01/02  11:20:30 
  24.9965, 121.4877 
  GPS Fixed 

• บรรทัดท่ีสองแสดงชื่อผูใช (คาที่ตั้งคือ “TR102”) 
• บรรทัดท่ีสาม คือ วัน เวลา (yyyy/mm/dd  hh:mm:ss) 
• บรรทัดท่ีสี่ คอื คาลองติจูด และ ละตจูิด ซึ่งสามารถสําเนาคานี้ไปใสใน Google Earth หรือ 

maps.google.com หรือแผนที่อื่น ๆ ที่รองรับ เพื่อดูตําแหนงบนแผนที่ 
• บรรทัดท่ีหา คือ การจับสญัญาณ GPS ไดหรือไม (ถาจับสัญญาณไมได ขอมูลของบรรทัดท่ี

สามและสี่ จะเปนของจุดสุดทายที่จับสัญญาณไ ด) 
 
 
 
 
 
 
 
 
 
 
 
 
 

item Description  
SOS  
Number  
1 ~ 3 

เมื่อกดปุม SOS TR-102 จะ
โทรไปหา 3 เลขหมายพรอม
กับสง SMS ขอมูลพิกัด
ตําแหนงไปดวย (ดูรูปที ่4 ใน
หนา 33) 

 
 
 
 
 

Quick Dial 
1 ~ 3 

ใสเลขหมายที่ตองการโทร
ออก 3 หมายเลขตามกํากับ 
(ดูรูปที่ 5 ในหนา 33) 
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item description 
เลขหมาย
โทรศัพท  
1~3 

3 เลขหมายนี้จะเหมือนกับเบอร 
Quick Dial ไมสามารถแกไข
จากหนาตางนี ้

เลขหมาย
โทรศัพท 
4~10 

ตั้งเลขหมาย 4-10 

 
 
 
 
 
 
 
 
 
 
 
 

item description 
IMEI International Mobile 

Equipment Identity 
Firmware 
Version 

Firmware version of TR-102 

Name ใสชื่อผูใชในชองนี้ (คาทีต่ั้งไว 
คือ TR-102) 

Phone ใสเลขหมายโทรศัพทของ TR-
102 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

item description 
GPRS user name 
GPRS user password 
GPRS apn 
GPRS_dns1 
GPRS_dns2 

โปรดขอคําแนะนํา
ในการตั้งคาจากผู
ใหบริการ GPRS 
ของทาน 

 
 
 
 
 
 
 
 
 
 
 

item Description 
GPRS Port คาทีต่ั้งไว คือ “5000” 
GPRS Sever 
Host Name 

ตั้งชื่อ GPRS Server Host 
Name 
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7. การใชงานเครื่อง 
7.1 การเปดปดเครื่อง 

• การเปด เมื่อเครื่องปดอยู ใหกดปุมปด/เปด 
คางไว 3 วินาที ไฟ LED ทั้ง 3 ดวง จะ
กระพริบไลเรียงจากบนลงลางแลวจะเขาสู
โหมดเตรียมพรอมโดยไฟ LED จะกระพริบ
ชา ๆ ถือวาเปดเครื่องเรียบรอยแลว 
(ระหวางกําลังเปดเครื่อง จะปดเครื่อง
ไมได) เมื่อเปดเครื่องแลว GPS จะเริม่
ทํางานหาตําแหนงเครื่อง โดยไฟ LED สี
เขียวจะเปดประมาณ 2-3 วินาที แลวจะดับ
ไป ถาหาตําแหนงไมไดใน 3 นาที GPS ก็
จะหยุดไป 30 นาที แลวจึงคนหาใหม ขอ
แนะนําใหอยูภายนอกอาคารเพื่อใหรับ
สัญญาณดาวเทียมไดดียิ่งขึ้นขณะเปดเครื่อง 

• การเปด เมื่อเครื่องเปดอยูกดปุม ปด/เปด คางไว 3 วินาทีไฟ LED ทั้ง 3 ดวงจะ
กระพริบชา ๆ จากลางขึ้นบน เมื่อไฟ LED ดับไปแลว แสดงวาปดเครื่องเรียบรอยแลว 

7.2 การตอบรับและวางสายโทรศพัท 
• เมื่อมีสายเรียกเขา กดปุมน้ีเพื่อรับสาย 
• ขณะสนทนา กดปุมน้ีเพื่อวางสาย 
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7.3 การปรับเสียงหูฟง 
• ขณะสนทนา สามารถเพิม่ระดับเสียงไดโดยกดป

“+” 
ุม 

• เมื่อกดปุมน้ีขณะสนทนา ผูที่โทรมาจะไมไดยิน
เสียงพูดของคุณ  กดปุมน้ีอีกครั้งเพื่อสนทนาตอ
ไดอีก 

• ขณะสนทนา สามารถลดระดับเสียงไดโดยกดปุม 
“-” 

 
 
 

7.4 การโทรออก 
• เมื่อต้ังคาเลขหมาย Quick Dial แลวกดปุม Quick 

Dial เมื่อโทรออกไปยังเลขหมายที่ตั้งไว การกดปุม 
Quick Dial ใหกดคางไวเกิน 1 วินาที แลวปลอย 
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7.5 การสง SMS แบบฉุกเฉิน 
• เมื่อต้ังคาเลขหมายสําหรับการสง SOS 

เรียบรอยแลวกดปุม SOS TR-102 ก็จะสง
ขอมูลตําแหนงไปยัง 3 เลขหมายที่ตั้งไวโดย 
SMS เพื่อหลีกเล่ียงการกดปุม SOS โดยบ
ใหกดปุม SOS น้ีคางไว 2 วินาที แลวปลอย ก็
จะสง SOS แบบฉุกเฉิน 

ังเอิญ 

• TR-102 จะโทรหา SOS เลขหมายที่ 1 เพื่อสง
ขอมูลตําแหนง และโทรหา SOS เลขหมายที่ 2 
และท่ี 3 ตามลําดับ 

 
เมื่อกดปุม SOS เครื่องจะทํางานอยางไร 
1. เพื่อยืนยันวามีการกดปุม SOS อยางถูกตอง 

TR-102 จะมีไฟ LED สแีดงกระพริบ 2 ครั้ง 
2. TR-102 จะคนหาตําแหนงตัวเองโดยแสดงไฟ GPS LED กระพริบ เมื่อจับสัญญาณได ไฟ 

LED จะเปดคาง 
3. TR-102 ก็จะปด GPS ไฟ LED สีเขียวจะดับ 
4. TR-102 เริ่มสงขอมูลตําแหนงดวย SMS โดยไฟ LED สีนํ้าเงินจะกระพริบ 1 ครั้งตอวินาที 
5. เมื่อสง SMS เสร็จแลว ไฟ LED สีนํ้าเงินก็จะกลับสูโหมดเตรียมพรอมโดยกระพริบ 1 ครั้งตอ 

3 วินาที 
6. ถาสง SMS ไดเรียบรอย TR-102 จะกระพริบไฟ LED สีแดง 2 ครั้ง 
7. ถาจับสัญญาณ GPS ไมไดใน 3 นาที ก็จะสง SMS ดวยขอความ “no fixed” และขอมูล

ตําแหนงสุดทายที่จับสัญญาณได 
 

8. การติดตามดวยโหมด SMS 
 8.1 การตั้งคารูปแบบการสง SMS 

• ตอ TR-102 เขากับ 
PC ทางชอง USB 

• เขาไปยังโหมดตั้ง
คา เลือกโหมด
โทรศัพทแลวเลือก 
SMS ใน  Return 
Type 
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8.2 การสง SMS จากโทรศัพทมือถือไปยัง TR-102 
• สง SMS ไปยัง TR-102 เพื่อใหสงขอมูลพิกัดตําแหนงกลับมา (ขอความที่สง SMS เปนอะไร

ก็ได หรือ ขอความวาง) 

8.3 TR-102 สง SMS ไปยังโทรศพัทมือถือ 
• เมื่อ TR-102 รับ SMS มาแลว ก็จะสงขอมูลพิกัดตําแหนงทาง SMS กลับมาในรูปแบบดังน้ี 

Position Report : 
TR-102 
2005/01/02   11:20:30 
24.9965, 121.4877 
GPS fixed 

 
 
 
 

8.4 การแสดงตําแหนงบนแผนที่  
• เปด Google Earth ขึ้นมากอน (รายละเอียดเพิ่มเติมของ Google Earth ดูไดใน “TR-102 

Supporting User Manual En_Free Google Earth Software.pdf” ซึ่งอยูใน CD-ROM ใน
แฟม “Manual”) 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

ใสคา Latitude/ 
Longtitude ที่ไดรับ
จาก SMS แลวคลิก 
Search เพื่อคนหา 

Google Earth จะ
แสดงตําแหนงบน
แผนที่ 
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• หรือเขาไปใน Internet Explorer และพิมพ “http://maps.google.com” เพื่อเขาไปยงั 
Google Map Website ซึ่งจะแสดงตําแหนงบนแผนที่เชนกัน 

 
 
 
 
 
 
 

เลือก Satellite 
หรือ Hybrid ทั้งน้ี
แลวแตพ้ืนที่นัน้จะ
มี Google Map 
รองรับหรือไม 

 
 
 
 
 
 
 ใสคา Latitude / 

Longtitude ทีไ่ด
จาก SMS แลว
คลิกที่ Search 

 
 
 
 
 
 
 Google Map ก็จะ

แสดงตําแหนงบน
แผนที ่
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9. การติดตามดวยโหมด GPRS 
     9.1 การตั้งคารูปแบบการสง GPRS 

• ตอ TR-102 กับ PC ทางชอง USB 
• เขาไปที่ Setup เลือกโหมดโทรศัพทแลวเลือก GPRS ที่ชอง Return Type 

 

 
 

9.2 การสั่งให TR-102 เชื่อมตอ Internet ดวย GPRS 
• ถา Answer Mode เปน Off ใชโทรศัพทมือถือโทรหา TR-102 หรือสง SMS ไปยัง TR-102 

เพื่อสั่งใหตอเขา Internet 
• ถา Answer Mode เปน On จะสงไดเพียง SMS เพื่อสั่งให TR-102 ตอเขา Internet 
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     9.3 การสงคําสัง่จาก Call Center ไปยัง TR-102  
•  สามารถสงคําสั่งไปยัง TR-102 โดยวิธีตอไปน้ีเพื่อให TR-102 สงขอมูลตําแหนง  กลับมา 

1) เปดโปรแกรม Call Center แลวคลิกไปที่ “GPRS”>”Start” บนแถบเมนู เพื่อ
เช่ือมตอไปยัง  Internet 

2) คลิก “GPRS”>”Send Message” เพื่อเปดหนาตางสงคําสั่ง 
3) เลือก Name, Return Mode และ Return Time ตามแตกรณี แลวคลิก OK 

เพื่ อสงคําสั่งออกไป 
4) โปรดดูตารางตอไปถึงวิธีที่จะเลือก “Return Mode” หรือ “ Return Time”. 
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Return Mode 
 

 
Return Time 
(second) 
 

 
Description 
 

 
Immediate 
report 

 
N/A 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะสงขอมูลกลับทันทีโดยจะสง
หนึ่งถึงสองครั้ง การเชื่อมตอ GPRS ยังคงอยู ขณะที่ TR-102 
อยูในโหมดนี้ไฟ LED สีน้ําเงินจะกระพริบ 1 ครั้งตอวินาที แลว
เริ่มจับสัญญาณ GPS โดยไฟ LED สีเขียวจะกระพริบ เมื่อจับ
สัญญาณไดแลวก็จะสงขอมูล ไฟ LED สีเขียวก็จะเปดคาง 
จนกวาจะมีคําสั่งครั้งตอไปใหสงขอมูลอีก 
 

 
Period report 

 
5 ~ 86400 
seconds 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะสงขอมูลกลับทุก ๆ ชวงเวลา
ตามที่ตั้งไว และการเชื่อมตอ GPRS ยังคงอยูเมื่อถึงชวงเวลา
ที่ตั้งไวแลว TR-102 จะเริ่มจับสัญญาณ GPS ไฟ LED สีเขียว
จะกระพริบ เมื่อจับสัญญาณไดแลว สงขอมูลไป ไฟ LED สี
เขียวจะเปดคางจนกวาสิ้นสุดชวงเวลา แลวจึงเริ่มใหมอีกครั้งใน
ชวงเวลาตอไปเรื่อย ๆ 
ความคลาดเคลื่อนของเวลาในการสงขอมูลกลับประมาณ 1-3 
วินาที หรือมากกวา ถาการเชื่อมตอ GPRS ไมเสถียร 
 

 
Stop connect 

 
N/A 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะหยุดการเชื่อมตอ GPRS และ
กลับไปสูโหมดหยุดนิ่ง 
 

 
Stop connect 
and set 
period report 

 
30 ~ 86400 
seconds 

 
เมื่อ TR-102 ไดรับคําสั่งนี้ ก็จะสงขอมูลกลับทันทีโดยจับ
สัญญาณ GPS ไฟ LED สีเขียวกระพริบ เมื่อจับสัญญาณไดไฟ 
LED สีเขียวเปดคาง และเชื่อมตอ GPRS เพื่อสงขอมูล โดยไฟ 
LED สีน้ําเงินกระพริบ 1 ครั้ง ตอวินาที หลังจากนี้ก็จะปด GPRS 
แลวอยูในโหมดหยุดนิ่ง ไฟ LED สีเขียวดับ ไฟ LED สีน้ําเงิน
กลับมาอยูในสถานะพรอม เมื่อครบชวงเวลาก็จะเริ่มใหม
เชื่อมตอ Internet แลวสงขอมูลอีก แสร็จแลวก็กลับเขาโหมด
หยุดนิ่งอีกครั้ง จะทํางานในลักษณะนี้ เมื่อถึงชวงเวลาที่ตั้งไว
ตอไปเรื่อย ๆ 
เนื่องจากเมื่อจับสัญญาณ GPS ไดแลวจะหยุดไปจนครบ
ชวงเวลาแลวจึงเริ่มจับสัญญาณใหม ทําใหตองใชเวลาบางใน
การจับสัญญาณ GPS ดังนั้นถาสัญญาณ GPSไมแรงพออาจ
ตองใชเวลามากกวา 3 นาที ในการจับสัญญาณ (และยังขึ้นอยู
กับความเสถียรของการเชื่อมตอ GPRS ดวย) 
 

 
1. ดูรายละเอียดการตั้ง Return Mode และ Second ไดทีไ่ฟล “TR-102 GPRS Access command 

Vx.x.pdf” ใน CD-ROM แฟม “Manual” 
2. เมื่อเปดเครื่อง TR-102 จะจําเอา “Return Mode” จากครั้งกอนที่จะปดเครื่อง 
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9.4 TR-102 สงขอมูลตําแหนงกลบัมายัง Call Center  
• เมื่อ TR-102 ไดรับคําสั่ง ก็จะสงขอมลูตําแหนงกลับมาโดย GPRS ใหคลิกท่ี GPRS ใน Call 

Center Program ก็จะเห็นขอมูลลาสุดอยูแถวบนสุดของรายการ 
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     9.5 การแสดงตําแหนงบนแผนที่ 
o คลิกที่ Map บนแถบเมนู เลือกใหโปรแกรม 

แสดงบน Google Map หรอื Google Earth 
o ถาคลิกที่ “View”>”Show Map” โปรแกรม 

Call Center จะให Google Map หรือ 
Google Earth ปรับปรุงการแสดงผลเมื่อรับ
ขอมูลใหม 

o หรือคลิก 2 ครั้ง ในแตละรายการก็จะแสดง
ตําแหนงบน Google Map หรือ Google 
Earth 
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10. รูปแบบการทํางานของ TR-102 ดวย SMS และ GPRS 
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11. การแกปญหาขัดของ และขอมูลความปลอดภัย 
 

อาการ สาเหตุ การแกไข 

ไมไดใสSIMการด ใหใสSIMการดเขาใน TR-
102 

ถาเปดเครื่อง TR-102 แลว
ไฟ LED 3 ดวงกระพริบ
พรอมกัน 

ใสSIMการดแลว แตมีรหัส 
PIN ปองกันการเขาถึงและ
ใสรหัสไมถูกตอง 

เอาSIMการดออกมาใสใน
โทรศัพทเพื่อปลดล็อคการ
ใสรหัส PIN แลวจึงใสSIM 
กลับเขาไปใน TR-102 ใหม
เมื่อยูในโหมด Setup ก็จะไม
ถามหารหัส PIN อีกตอไป 

หรือตอ TR-102 เขาไปที่ 
PC เปด  Setup Mode ใน 
Call Center Program เพื่อ
ใสรหัสที่ถูกตอง 

เมื่อเปด TR-102 แลวไฟ 
LED สีนํ้าเงินเปดแสดง
สถานะ GSM 

สัญญาณ GSM ออน ใหเคล่ือนยายไปบริเวณท่ีมี
สัญญาณแรงกวา 

 
• หาขอมูลเพิ่มเติมเรื่  อง Google Earth Software และ Free DDNS Service, ใหดูที่ “TR-101 

Supporting User Manual EN 1_ Free DDNS Service.pdf” และ “TR-101 Supporting 
User Manual En_Free Google Earth Software.pdf” ซึ่งอยูใน CD-ROM ในแฟม 
“Manual” 

• ในสถานะการณทั่วไป ควรชารจแบตเตอรี่ประมาณ 4-5 ช่ัวโมง โดยปดเครื่องไฟก็จะเต็ม ถา
ชารจโดยเปดเครื่องดวยก็จะใชเวลานานกวานี้ 

• ฝาปดชองตอ USB ของ TR-102 จะมีเดือยเล็ก ๆ อยู (ดูในรูป
ขวามือ) ใหกดลงดวยความแรงเล็กนอยเพื่อปดใหสนิท ซึ่งจะมีเสียง
คลิกเบา ๆ เมื่อปดสนิท 

• อยาตอ TR-102 กับตัวอแด็ปเตอรชารจไฟ ขณะที่กําลังจะเปดเครื่อง 
มิฉะน้ันจะเปดเครื่องไดไมสมบูรณ 

• อยาตอ TR-102 เขาชอง USB ขณะทีเ่ปลื่ยนแบตเตอรี่มิฉะน้ัน จะมี
เสียงดัง 

• ถาปด TR-102 ไมได ใหเปดฝาถอดแบตเตอรี่ออก 3 วินาทีเปนอยางนอย ใสแบตเตอรี่กลับ
แลวเปดใหมอีกครั้ง  
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• เมื่อคลิกท่ี KMLจะสงขอมูลไดก็ตอเมื่อ 
มีรายการที่จับสัญญาณ GPS ไดบาง 
(2D หรือ 3D) ถาทุกรายการจับสัญญาณ 
ไมไดเลย “No Fix” ก็จะสงขอมูลเปนไฟล 
KMLไมไดซึ่งจะเห็นขอความ error วา 
“No Effective Data” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• เมื่อเปดเครื่ง จะเริ่มกระบวนการเปดเครื่องตามลําดับ จะไดยินเสียง ตูด จากลําโพง ซึ่งเปน
เรื่องปกติ ไมมีปญหากับตัวเครื่อง 

• โปรดหลีกเล่ียงการเก็บวางอุปกรณไวในที่มีความรอนสูงหรือความชื้นมาก และอยาทิ้งเครื่อง
ไวในรถที่ปดสนิทจอดอยูกลางแดด ความรอนที่สูงมากอาจทําความเสียหาย ใหกับอุปกรณ 
หรือ แบตเตอรี่ อาจระเบดิได 

• เมื่อใช  TR-102 โทรออก แตผูรับไมตอบรับ (ไมรวมถึงการปดเครื่อง สายไมวาง หรือวาง
สาย) จนเขาสูโหมดการฝากขอความดวยเสียง (Voice box) ถาไมตองการฝากขอความ 
โปรดแนใจวาไดกดปุมวางสายที่ TR-102 เรียบรอยแลว มิเชนน้ัน TR-102 จะเปดติดตอกับ
ระบบฝากขอความ และไมสามารถกลบัมาอยูในโหมดเตรียมพรอม 

• อยาถือ TR-102  แนบหูเมื่อมีเสียงเรียกเขา เมื่อตองการรับโทรศัพท ใหกดปุมตอบรับกอนที่
จะนํา TR-102  มาฟงเสียง ทั้งน้ีเพื่อปองกันอันตรายจากการฟงเสียงดังเกินขนาด 
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